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Introduction

The Free Delta Editor (FDE) is  a standalone expert editor and interactive software management
system for editing  DELTA data  and directives  files and running DELTA based programs: CONFOR, KEY,
DIST (and INTKEY5/INTIMATE5 in the MS-Windows version) and viewing/printing the results. With FDE, you
can do a complete analysis  of  a taxonomic descriptive dataset,  from data-checking to key construction,
under a uniform, menu-driven, easily operated shell.

This tool provides an interactive, user-friendly interface to DELTA-format files as a real DELTA data
entry/maintenance program,  able to handle large amounts of  data, limited only by available memory.. It is
possible to insert or delete items, characters, and states, through forms and dialog boxes, without having to
worry  about  the  consistency  of  the  DELTA files.  A database-like  interface  makes it  easy  to  setup  and
maintain the main DELTA data files (ITEMS, CHARS and SPECS), as well as several of the DELTA directives
files (TONAT, TOKEY, TODIS). A spreadsheet-like visualization facility for item and character data is also
available. 

It also makes possible to start all DELTA programs and create dichotomous keys for identification,
natural-language descriptions,  statistical  reports,  distance matrices,  cluster  and ordination analysis,  etc.,
providing a viewer to look at and print the results (output files). 

It also integrates with the R environment for statistical computing and graphics to perform cluster
analysis on distance matrices generated from DELTA data,  as well  as with the TNT parsimony analysis
program. 

On the other side, although Free Delta is able to process regular DELTA-coded files, it is not identical
to  the  original  DELTA system.  We  implemented all  improvements  that  are  convenient,  based  on  our
experience with other taxonomic computing systems. In particular, it has a better treatment of quantitative
data, more analytical and format-conversion procedures, and many other useful features. See Appendix 3 for
a summary of the differences between Free Delta and the original DELTA system.
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Requirements

FDE requires:

• Microsoft Windows '95, NT 4.0, or later versions of these systems (’98, Me, 2000, XP, Vista,
7, 8, 8.1, 10).

• Many distributions of GNU/Linux 2.0 or later.

• The DELTA suite of programs (CONFOR, KEY, DIST).

When installed, FDE requires about 8 MB of disk space.
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Distribution

The latest versions of FDE are available from the Free   DELTA website  at SourceForge  . The source
code is also available from GitHub.

The distribution package consists of an executable installation file for the MS-Windows version and a
Debian package for the GNU/Linux version, both containing the program and documentation. 

To install the program, download and save the installation package to any folder on your computer,
and execute it by double-clicking on its name  from your file manager program. After installation, start the
software by  clicking on the proper item at the start  menu. Executable versions for MacOSX are not yet
available. 
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License

FDE is  free  software,  available  under  the terms of  the  GNU General  Public  License version 3
(GPL3). The DELTA programs (CONFOR, KEY, DIST) are distributed under the terms of the Mozilla Public
License version 2 (MPL2).
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User Interface

The FDE user interface resembles, but is not a clone of, that of the CSIRO and ALA Delta Editors.
See Appendix 3 for a summary of the differences between Free Delta and the original DELTA system.

Main Window

In the FDE main window, two views of the data are always available: the List View (Figure 1) and the
Matrix View (Figure 2). These views are accessible by clicking on the labeled tabs above the Items list. 

In the List View (the default), the main window consists of three panels (Figure 1). The upper left
pane displays the items (taxa) list, the upper right pane displays the character tree, and in the lower panel
the attribute values are displayed and edited.

Figure 1 – FDE List View.

The Matrix View (Figure 2) provides an interface similar to that of a spreadsheet program like MS-
Excel or OO-Calc.
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Figure 2 – FDE Matrix View.

Clicking the right mouse button on each of the panes opens a popup menu with options for inserting,
modifying or deleting items or characters in the list. Double-clicking on an item or character will open the item
(Figure 3) or character editor dialog (Figure 4). 
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Item Editor Dialog

This dialog (Figure 3) allows the inclusion or modification of item (taxon) names. It may be opened
either by the Add Item, Edit Item, and Insert Item options from the Edit menu; by right-clicking the mouse in
the item list of the List View panel and selecting ‘Insert new item’ or ‘Append new item’ options from the
popup menu; or by double-clicking on an item name in the List View. 

Comments can be provided between angle brackets (<>) and should be used for the taxon authority.

Figure 3 – Item editor dialog.
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Character Editor Dialog

This dialog (Figure 4) allows the inclusion or modification of character names and their associated
states, notes, and dependencies. It may be opened either by the Add Character, Edit Character, and Insert
Character options from the Edit menu; by right-clicking the mouse in the character tree of the List View panel
and selecting ‘Insert new character’ or ‘Append new character’ options from the popup menu; or by double-
clicking on a character name in the List View. 

This dialog has a number of panels. These panels contains several different controls, which can be
selected by tabs, for editing the character descriptions, types, states, and units, as well as character notes
and dependencies.

Character description. This is a simple edit control containing the ‘feature’, or basic description of the
character. As with ‘conventional’ DELTA coding, the feature description should usually begin with a lower-
case letter. Comments can be provided between angle brackets (<>).

Character types. This is a ‘radio button’ control that indicates the character type. The type should be
chosen for any newly define character. It is possible to freely reassign the type of a character once it has
been defined.

Character  states.  This panel  contains  a  list  of  currently  defined  character  states  for  qualitative
(unordered and ordered multistate) characters, a check box and a group of image buttons. The user selects
among states via the list control. The description of each state may then be edited by clicking the ‘Edit’ button

( ). New states can be appended to the end of the list by clicking the ‘Add’ button ( ). Clicking the

‘Delete’ button ( ) deletes the currently selected state. States in the list control can be re-ordered by using

the ‘Up’ ( ) and ‘Down’ ( ) buttons. The ‘Clear’ button ( ) deletes the entire list of states. This panel is
disabled for quantitative and text characters.

The ‘Implicit’ check box allows the specification of the currently selected state as the ‘implicit’ state.
When the character is not recorded for a taxon, the implicit state value is assumed. 

Character unit. This is a simple edit control containing the character unit for quantitative (integer and
real) characters. This field is disabled for qualitative and text characters.
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Figure 4 – Character editor dialog.

Character Notes Dialog

This panel (Figure 5) consists of a single large text edit control, where supplementary information
(notes) about the character may be entered.
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Figure 5 -  Character notes dialog.

Character Dependencies Dialog

This panel (Figure 6) is used for defining ‘controlling attributes’; that is, combinations of one or more
states within a character, which when encoded for in a given item can make other ‘dependent’ characters
inapplicable. 

The  panel  contains  a  drop-down  list  of  controlling  attributes  defined  for  the  currently  selected
character  and  a checklist  box containing  the  characters within  the dataset.  To define a new controlling
attribute, select  it  from the list of controlling attributes  and use the  checklist box to select  the characters
which are made inapplicable by that attribute.
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Figure 6 -  Character dependencies dialog;

Attribute Editor Panel

This panel  (lower-left pane) allows to enter and edit item descriptions. 

 It displays the DELTA encoding for the currently selected item and character, using the conventional
DELTA style.  Angle  brackets  should  be  placed  around comments,  but  should  not  be  used  around text
attributes.
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Operation

File Alt-F

The File menu offers choices for opening, saving or printing files, importing and exporting data, and
exiting the program.

New Ctrl-N

Automatically opens a blank dataset for editing with the title of "Untitled". You can start entering data
right away.

Open Ctrl-O

The Open command displays the File Open dialog box. In this dialog box you select the data file you
want to edit.

  Under Microsoft Windows, it is also possible to open a file in FDE by double clicking on a Free
Delta data file in Windows Explorer, identified by the extension ‘.dtz’ (unless extensions have been hidden in
the Folder Options),or by a Free Delta icon (' ).

Close

Save data in the current dataset to disk and close the dataset.  If your data file is titled "Untitled", you
will be asked to supply a file name.  Otherwise, the data is saved to disk using the current window title. If you
have made changes but not saved them, the program will ask whether you want to save or discard your
changes before you close the file.

This command is disabled until you open a dataset for editing.

Save Ctrl-S

Save data in the current dataset to disk and continue editing. If your window is titled "Untitled", you
will be asked to supply a file name. Otherwise, the data is saved to disk using the current window title.

The original file is saved as a backup copy with the extension .BAK, and any old backup copy is
deleted.

This command is disabled until you open a dataset for editing.

Save As

Save data in the current dataset to disk under a new file name. You will be asked to which file you
would like to save the data. The file may be an existing disk file, or a new file.

Once your data is saved, you can continue using the editor on the current editi. Note that the window
title will change to reflect your new file name.

The original file is saved as a backup copy with the extension .BAK, and any old backup copy is
deleted.

This command is disabled until you open a dataset for editing.

Print

Prints the characters, coded items, or item names.

This command is disabled until you open a dataset for editing.
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Print the Characters

Runs CONFOR with directives file PRINTC, to output the character list in a more readable form, with
optional headings.

Print the Items

Runs CONFOR with directives file PRINTI, to reformat and output the item descriptions in a more
readable form, suitable for publication.

Print the Item Names

Runs CONFOR with directives file PRINTN, to print the item names.

Import

Imports data from other programs into a Free DELTA dataset.

DELTA Format

Converts the data contained in text files in the DELTA format (the CHARS, ITEMS, and SPECS files)
into a Free DELTA dataset.

The program will prompt for the folder where the DELTA files to be imported can be found.

Text Format

Converts a file of comma-separated values into an items file of a Free DELTA dataset.

   Each line of the input file corresponds to an item, with values separated by commas. The first value
on the line is the item name, and subsequent values are the DELTA-format character values, which may
include comments. A character value may be optionally enclosed in double quotes.

A file  in  this  format  can  be exported  from an electronic  spreadsheet,  in  which  the first  column
contains the item names, and subsequent columns contain the character values.

The program will prompt for the name of the file of comma-separated values.

Export

Exports data into a variety of standard formats (DELTA, NEXUS, TNT, XDELTA) for use by other
programs.

This command is disabled until you open a dataset for editing.

DELTA Format

Converts the data into text files in the DELTA format (the CHARS, ITEMS, and SPECS files).

XDELTA Format

Converts the data into the XDELTA XML file format defined Dodds (1999).

Text Format

Converts the data into a tab-delimited text file.
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Clear Recent Files List

Lists the most recently opened files. To open a file from the list, click on its name. 

Quit Ctrl-Q

The Exit command terminates the program.  If you have made changes but not saved them, the
program will ask whether you want to save or discard your changes before you exit the program. 
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Edit Alt-E

The Edit menu allows you to add, modify, or delete items and characters. You can also “clone” (copy)
an item, enter item descriptions, merge character lists, or view images using the INTIMATE image-annotation
program.

Add Item Alt-Ins

Displays the Item Editor Dialog (Figure 3) which allows the input of an item (taxon) name. The new
item is appended to the end of list.

This command is disabled until you open a dataset for editing.

Insert Item Shift-Alt-Ins

Displays the Item Editor Dialog (Figure 3) which allows the input of an item (taxon) name. The new
item is inserted at the current position.

This command is disabled until you open a dataset for editing.

Edit Item Ctrl-I

Displays the Item Editor Dialog (Figure 3) which allows to modify the currently selected item (taxon)
name.

This command is disabled until you open a dataset for editing.

Delete Item Alt-Del

Deletes the currently selected item. 

This command is disabled until you open a dataset for editing.

Clone Item Ctrl-C

Clones (ie., copy) the entire description of the currently selected item, The cloned item is inserted at
the current position.

This command is disabled until you open a dataset for editing.

Add Character Ctrl-Ins

Displays the Character Editor Dialog (Figure 4) which allows the input of data for each character.
The new character is appended to the end of list.

This command is disabled until you open a dataset for editing.

Insert Character Shift-Ctrl-Ins

Displays the Character Editor Dialog (Figure 4) which allows the input of data for each character.
The new character is inserted at the current position.

This command is disabled until you open a dataset for editing.

Edit Character Ctrl-E

Displays the Character Editor Dialog (Figure 4) which allows to modify the data related to currently
the selected character.
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This command is disabled until you open a dataset for editing.

Delete Character Ctrl-Del

Deletes the currently selected character.. 

This command is disabled until you open a dataset for editing.

Merge Character Lists Ctrl-M

Merge (join) two character lists, by appending another character list to that of the currently editing
dataset.

The program will  prompt for the name of the folder where the CHARS file to be merged can be
found.

This command is disabled until you open a dataset for editing.

Database Title Ctrl-T

Displays a dialog box (Figure 7) which allows you to enter or modify the descriptive title (heading) of
the current dataset, which may subsequently be used to label the output.

This command is disabled until you open a dataset for editing.

Figure 7 – Database title dialog.

Images Ctrl-G

This command runs INTIMATE (INTkey IMage AnnoTation Editor), a program for associating images
with particular characters or items, and to aid in the placement of various forms of annotation on these
images. See the INTIMATE documentation (Dallwitz et al. 1993) for details.

This command is disabled until you open a dataset for editing.

Script

Displays a text editor window with syntax-highlighting (Figure 8), which allows editing and running of
CONFOR/KEY/DIST directives files containing sets of instructions that will be read and processed by various
DELTA programs (similar to the ‘action sets’ used by the CSIRO/ALA DELTA Editors).

This command is disabled until you open a dataset for editing.
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Figure 8 -  The script editor
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Search Alt-S

The Search menu allows you to look for items or characters within your current editing dataset. 

Find Ctrl-F

Find a particular bit of text in your current editing dataset. A dialog box (Figure 9) will appear asking
you what text to find, and gives you the option of finding text that is case sensitive (which means text must
match the case of the text you entered before a match is found) or whole words only which means that no
match will be found if the text you input is part of a word).

This command is disabled until you open a dataset for editing.

Figure 9 -  Find text dialog.

Find Next F3

This will allow you to quickly repeat the last Find operation without having to enter your search 
parameters again.

This command is disabled until you open a dataset for editing.

Go to Line Ctrl-G

This will prompt you to enter a specific item/character line number (Figure 10), to which the cursor
will be moved.

This command is disabled until you open a dataset for editing.

Figure 10 – Go to line dialog.
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Descriptions Alt-D 

The Descriptions menu runs the format-conversion program CONFOR to generate natural language
descriptions, produce a statistical summary of the data, and print a list of uncoded characters.

Natural Language

Runs  CONFOR  with  directives  file  TONAT  (Figure  11)  in  order  to  produce  natural-language
descriptions (Figure 11).

This command is disabled until you open a dataset for editing.

Figure 11 – TONAT directives dialog.

  The *ITEM SUBHEADINGS field must be entered as a semicolon-separated list, for example: 2. Habit,
vegetative morphology; 12. Inflorescence; 25. Female-sterile spikelets; 26. Female-fertile spikelets, florets,
fruit;  68.  Photosynthetic  pathway,  leaf  blade  anatomy;  77.  Special  diagnostic  feature;  78.  Taxonomy,
distribution; 87. Anatomical references; 88. Illustrations.
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Figure 12 -  Natural-language description.

Character Summary

Runs CONFOR with directives file SUMMARY in order to print a statistical summary of the data
(Figure 13).

Numeric characters are expressed in terms of mean, standard deviation, maximum, and minimum,
while multistate characters show the distribution of the items according to the individual states.

This command is disabled until you open a dataset for editing.
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Figure 13 – Character summary report.

Uncoded Characters

Runs CONFOR with directives file UNCODED, to print the uncoded characters (Figure 14).

This command is disabled until you open a dataset for editing.
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Figure 14 – Uncoded characters report.
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Keys Alt-K

The  Keys  menu  runs  the  key  generation-program  KEY  and  the  interactive  identification  and
information retrieval program INTKEY5.

Conventional Key

Runs  KEY,  a  program  for  generating  identification  keys  (Dallwitz,  1974),  in  the  conventional
bracketed, or in a tabular format resembling a tree diagram.

Input  to  the  program  consists  of  two  binary files  (KCHARS  and  KITEMS),  produced  by  the
TRANSLATE INTO KEY FORMAT option of CONFOR, with directives file TOKEY  (Figure 15)  in order to
convert the data into the format required by the key-generation program KEY, and an optional directives file
(KEY), which controls execution of the program. See Chapter 5 of the DELTA User's Guide (Dallwitz et al.,
1993) for details.

Figure 15 – TOKEY directives dialog.

The output file contains the dichotomous key in bracketed (Figure 16) or in tabular format (or both).

This command is disabled until you open a dataset for editing.
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Figure 16 -  Dichotomous key in bracketed format.

Interactive Key

Runs INTKEY5, an interactive program for identifying a specimen by comparing its attributes with
stored descriptions of taxa. The program can also be used to query the stored data (Watson  et al., 1988,
1989; Bruhl et al., 1992; Dallwitz, 1993).

Input  to  the  program  consists  of  two  binary files  (ICHARS  and  IITEMS)  produced  by  the
TRANSLATE INTO INTKEY FORMAT option of CONFOR, and an optional initialization  file (INTKEY.INK)
containing commands which are executed when the program starts. See Chapter 7 of the  DELTA User's
Guide (Dallwitz et al., 1993) for details.

The program INTKEY5 offers research features for taxonomic identification and information retrieval
which are lacking in less sophisticated programs (Dallwitz, 1993). They include optional display of extended
notes on characters and character state definitions; direct handling of numeric values, which therefore do not
have to be arbitrarily ranged; the ability to alter the treatments of unknowns, inapplicables and overlapping
values,  as required for  different  applications;  retrieving text  information (as synonyms, references,  etc.);
restricting operations to subsets of characters or taxa; defining keywords to represent subsets of characters
and taxa; locating characters by included words, and taxa directly by name; specifying character reliabilities
(i.e., weights) appropriate for particular purposes (rendering practical the calculation of "best" characters for
large  sets  of  characters  and taxa);  obtaining  lists  of  taxa  possessing  or  lacking  particular  attributes  or
combinations of attributes; listing similarities or differences between taxa; describing, comparing, contrasting,
and diagnosing taxa, in terms of specified sets of characters, and generating files suitable for input to other
DELTA programs (for example, to highlight diagnostic features in printed descriptions). INTKEY5 permits
screen display of digitized pictures, at high resolutions and in large numbers; and it handles large sets of
data, with acceptable response times.

 This option is available only under Microsoft Windows.
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Matrix Alt-M

The Matrix menu runs the distance-matrix program DIST and, if available, the R environment for
statistical computing and graphics. It also offers an option for running the parsimony analysis program TNT.

Distance Matrix

Runs DIST, a program for generating a distance matrix. Distances are calculated among taxa using
a modified version of Gower's (1971) general similarity coefficient. See Chapter 4 of Sneath & Sokal (1973)
for an explanation.

Input to the program consists of a  binary file  (DITEMS) produced by the TRANSLATE INTO DIST
FORMAT option  of  CONFOR  (Figure  17),  in  order  to  convert  the  data  into  the format  required  by the
distance-matrix  program  DIST,  and  an  optional  directives  file  (DIST),  which  controls  execution  of  the
program. See Chapter 6 of the DELTA User's Guide (Dallwitz et al., 1993) for details.

Figure 17 – TODIS directives dialog.

The output file contains the distance matrix in upper-triangular form, without the diagonal (Figure 18).

This command is disabled until you open a dataset for editing.
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Figure 18 – Output distance matrix.

Cluster Analysis

Runs  R, a free software environment for statistical computing and graphics  (Ihaka & Gentleman,
1996),  to  perform agglomerative clustering on the distance matrix generated by the DIST program (Figure
19)  by  seven  combinatorial sorting strategies  (single linkage, complete linkage, average linkage, weighted
linkage, centroid, median, and Ward’s method), generating a dendrogram (Figure 20). See Chapter 5 of
Sneath & Sokal (1973) for an explanation of these methods.

Figure 19 – Clustering options dialog.

This command is disabled until you open a dataset for editing and a distance matrix is generated.
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Figurae 20 – Dendrogram generated from the distance matrix.

This option works on distance matrices produced by the program DIST.

Principal Coordinates Analysis

Runs R, to perform an ordination of the distance matrix generated by the DIST program (Figure 21)
using the method of principal coordinates (Gower 1966).

This command is disabled until you open a dataset for editing  and a distance matrix is generated.
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Figure 21 – Principal coordinates analysis generated from the distance matrix.

This option works on distance matrices produced by the program DIST.

Parsimony Analysis

Runs CONFOR with directives file TOHEN or TONEX (Figure 22) in order to convert the data into
the format required by the phylogenetic analysis programs PAUP (Swofford 2003) and TNT (Goloboff et al.
2008).

Figure 22 -  TOHEN/TONEX directives dialog.

This command is disabled until you open a dataset for editing.

 This option is available only under Microsoft Windows (32- and 64-bit) and GNU/Linux (64-bt).
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Language Alt-L

The Language menu  allows to  change the default  language.  The Free Delta  Editor  is  currently
available in English (default), French, and Brazilian Portuguese. The selected language will also be used in
IINTKEY5 interface and help file (INTKEY.HIN).

Any  interested  person  can  provide  a  translation  for  her/his  native  language.  No  knowledge  of
programming is required, just a freely available and easy to use software tool as POEdit or Virtaal. Please
contact me for further details. 
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Help Alt-H

The Help menu provides access to an About box which gives general information about the program
and the operating system.

Help Index F1

Displays the main index or contents page for the program help file.

About FDE

Displays a dialog box that shows some information about the program, as the name, a copyright
notice, and a version number, as well as about the operating system on which the program is running (Figure
23).

Figure 23 – FDE information dialog.
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Remarks

FDE always looks for the DELTA executables (CONFOR, KEY, DIST) in the installation directory.

  FDE only runs the DELTA programs KEY, INTKEY5, and DIST if  it detects the presence of  the
mandatory input files to these programs (KCHARS and KITEMS for KEY, ICHARS and IITEMS for INTKEY5,
and DITEMS for DIST), which implies that the user must first runs CONFOR via the Descriptions, Keys, or
Matrix menus,  in  order  to  proceed  to  generating natural-language  descriptions  and  dichotomous  keys,
running interactive identification, or calculating a distance matrix.

FDE is quite  independent  of  the  CSIRO/ALA Delta programs, so there is  no need to install  (or
uninstall, in case any of them is already installed on a user's machine) these tools beforehand. The exception
is if one wants to use an interactive key from the Free Delta Editor, which then requires that the CSIRO Delta
INTKEY5 program be installed separately (this program is not provided with the Free Delta Editor installation
package).

You can enter data either by typing the data directly into the editor or by importing existing DELTA 
text files (CHARS, ITEMS, SPECS) using the File/Import option of the main menu.

See Appendix  3  for  a  summary  of  the differences  between Free  Delta  and  the  original  DELTA
system.
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Appendix 1. About DELTA

The  DELTA (DEscription Language for TAxonomy) format developed in Australia by Mike Dallwitz
and his collaborators (Dallwitz, 1980, 1993) is an internationally recognized standard for coding descriptive
taxonomic  data.  The  associated  programs  which  comprise  the  DELTA  System  provide  facilities  for
maintaining data, producing natural language descriptions and keys, interactive identification and information
retrieval, and converting data to formats required by programs for cladistic and phenetic analysis.

The DELTA format allows all kinds of  taxonomic characters, whether they be qualitative (binary or
multistate, ordered or unordered) or quantitative (integer or real, with units if needed). Comments are allowed
anywhere,  and  character  dependency  can  be  described.  Directives  are  included  to  control  computer
processing.

The DELTA system thus combines traditional taxonomic practice with modern computer technology
to produce a key tool which can be used by biologists to integrate biodiversity information.

Several  sets  of  data  have  already  been prepared  using  DELTA,  as  for  flowering  plant  families
(Watson & Dallwitz, 1991), grasses (Watson & Dallwitz, 1981; Watson et al., 1986a, 1986b, 1989), sedges
(Bruhl et al., 1992), legumes (Watson, 1981), beetles (Askevold & O'Brien, 1994), plant viruses (Boswell et
al., 1986), etc. Some of these datasets incorporate line, gray-scale, and colour images for characters and/or
taxa.

A complete description of the DELTA format and directives is given by Dallwitz et al. (1993). Other
very useful sources of information on DELTA are Webster (1988), Partridge  et al. (1993), Askevold (1993)
and Coleman  et al. (2010). Dallwitz & Paine (1991) provide a detailed technical  definition of the DELTA
format. See also Chapter 5 of Pankhurst (1991) for a very clear explanation of DELTA.

Characters and Attributes

A character is a way of describing a taxon. The DELTA format recognizes the following character
types:

• multistate (qualitative) ordered or unordered

• numeric (quantitative) integer or real

• free text

A multistate character has two or more states, eg:

#5.  caudal fin colour/

1.  light yellow/

2.  blue <rarely>/

A numeric value may have units, eg:

#6.  standard length/

mm/

Text characters are enclosed in angle brackets, eg:

#10. <geographic distribution>/

Each character must be preceded by a cross hatch (#), a unique number, a period (.), and a space.
Each character state is preceded by a number, a period, and a space. The characters and character states
must be terminated by a slash (/). Units in numeric characters have no state number, and are also terminated
by a slash.  Comments must be enclosed in angle brackets (<>); the left (opening) bracket must be preceded
by a blank, and the right (closing) bracket must be followed by a blank or slash. These comments are used
by the interactive identification program, INTKEY, but do not appear in natural-language descriptions or keys.

An attribute is the description applied to a taxon or specimen, coded in DELTA format, eg:

5,1 6,20-45 10<Bermuda and Massachusetts to Brazil>

which would read:
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Caudal fin colour light yellow. Standard length 20 to 45 mm. Bermuda and Massachusetts to Brazil.

A typical  attribute  coded in  DELTA format  consists  of  a  character  number  and a state  number,
separated by a comma (eg., 5,1). Text attributes consist of a character number with text contained within
angle brackets (eg.,  10<Bermuda and Massachusetts to Brazil>).  We can also have several  states of a
character  separated by "/"  (meaning  or),  as well  as by "&"  (meaning  and).  Ranges are denoted by "-"
(meaning to). The three separators /, -, and & can be combined within the same attribute, and comments can
be associated with any of the character states within an attribute. Ranges of values of numeric characters
can include parentheses to indicate values outside the normal range.

Attributes may sometimes be unrecorded or inapplicable.
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Appendix 2. DELTA Library 

The DELTA Library is a general-purpose collection of Free Pascal routines for handling text files in
DELTA format. They are intended for use within the biological research community to provide processing
routines  for  reading  and  parsing  DELTA datasets,  and  so  were  designed with  the  following  (optimistic)
guidelines:

• Ease of use. Keep parameters to a minimum.

• Data independence. Work with any DELTA datafile, anywhere, anytime.

• Support for both CONFOR and PANKEY directives and format conventions.

DELTA Library may be freely distributed and used,  under the terms of the  GNU Lesser General
Public License version 2 (LGPL2). Feel free to incorporate these routines into your own individual application
programs or database systems. The latest versions can be downloaded from the Free DELTA website.
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Appendix 3. Differences between Free Delta and DELTA

• The Free Delta Editor uses conventional zip-compressed files (with the ‘.dtz’ extension) to
store  all  DELTA-formatted  data  (items,  characters,  specifications,  and  directives).  At  a
minimum,  these  files  must  include  the  three  basic  DELTA files  (CHARS,  ITEMS,  and
SPECS) and can be created either by exporting an already existing dataset from the CSIRO
Delta or ALA Delta programs and compressing them into a zip file (changing its extension

to .dtz), or by using the Import option from the File menu. The Free Delta Editor is not able
to read or import the files in '.dlt' format used by the CSIRO/ALA Delta Editors.

• The  mandatory  DELTA  directives  *MAXIMUM  NUMBER  OF  STATES,  *NUMBER  OF
CHARACTERS and *MAXIMUM NUMBER OF ITEMS are not used by the Free Delta Editor
parsing routines; instead, the routines which read DELTA obtain the required information
from the data files themselves.

• The *MANDATORY CHARACTERS directive is ignored by the Free Delta Editor.

• The Free Delta Editor parsing routines do not support ranges of character numbers in the
*CHARACTER NOTES directive, so character numbers must be written out separately for
each character in the CNOTES file, eg #6-8 should be written out as #6, #7, #8.

• Nested inner comments (‘<< >>’) are not supported in the Free Delta Editor.

• Single (‘) or double (“) quotes in item descriptions are not allowed in the Free Delta Editor.. 

• RTF (Rich Text  Format)  marks are not  interpreted by the Free Delta  Editor;  if  they are
present in the data, they are kept but are not supported whatsoever.
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Appendix 4. Importing data from CSIRO DELTA Editor

The Free Delta Editor is not able to directly read files in '.dlt' format used by the CSIRO/ALA Delta 
Editors. Before these data can be used by FDE, they must be ‘exported’ to text files. These comprise data 
files in the DELTA text format (SPECS – specifications; CHARS – character list, and ITEMS – item (taxon) 
descriptions). 

To export data stored in a .dlt file to DELTA text files, execute the CSIRO or ALA Editor and select the
‘File > Export Directives’ menu option. The following dialog will be displayed (Figure 24). 

Figure 24 -  CSIRO DELTA Editor export dialog.

Select only the mandatory data files (CHARS, ITEMS, SPECS and, if any, CNOTES) and click ‘OK’. 
An ‘Export Status’ window will show progress. When the process is finished, click ‘Done’ and the an ‘Export 
Log’ window will be displayed. 

To import the data just exported from the DELTA Editor into the Free Delta Editor, execute FDE and 
select the ‘File > Import > DELTA’ menu option. The following dialog will be displayed (Figure 25). 
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Figure 25 – FDE  import dialog.

Select the directory in which the DELTA text files exported from the DELTA Editor were saved. A ‘File
Save’ dialog box will be displayed for entering the name of the file which will store the imported data.
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